Quartus Il Introduction Using Verilog Design

This tutorial presents an introduction to the Qua@uﬁ CAD system. It gives a general overview of a typi-
cal CAD flow for designing circuits that are implemented byngsFPGA devices, and shows how this flow is
realized in the Quartus Il software. The design procesduistibited by giving step-by-step instructions for using
the Quartus Il software to implement a very simple circuiaimAltera FPGA device.

The Quartus Il system includes full support for all of the plap methods of entering a description of the
desired circuit into a CAD system. This tutorial makes usthefVerilog design entry method, in which the user
specifies the desired circuit in the Verilog hardware desiom language. Two other versions of this tutorial are
also available; one uses the VHDL hardware descriptiondagg and the other is based on defining the desired
circuit in the form of a schematic diagram.

The last step in the design process involves configuring &ségded circuit in an actual FPGA device. To
show how this is done, it is assumed that the user has accssAdtera DE2 Development and Education board
connected to a computer that has Quartus Il software iegtalA reader who does not have access to the DE2
board will still find the tutorial useful to learn how the FP@®ogramming and configuration task is performed.

The screen captures in the tutorial were obtained using tret@s 1l version 9.0; if other versions of the
software are used, some of the images may be slightly differe
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Computer Aided Design (CAD) software makes it easy to imgleta desired logic circuit by using a pro-
grammable logic device, such as a field-programmable gety @FPGA) chip. A typical FPGA CAD flow is
illustrated in Figure 1.
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Figure 1. Typical CAD flow.

The CAD flow involves the following steps:

e Design Entry — the desired circuit is specified either by means of a schierdagram, or by using a
hardware description language, such as Verilog or VHDL

e Synthesis-the entered design is synthesized into a circuit that stsef the logic elements (LES) provided
in the FPGA chip

e Functional Simulation — the synthesized circuit is tested to verify its functiot@irectness; this simulation
does not take into account any timing issues



e Fitting — the CAD Fitter tool determines the placement of the LEs @effim the netlist into the LEs in
an actual FPGA chip; it also chooses routing wires in the thimake the required connections between
specific LEs

e Timing Analysis — propagation delays along the various paths in the fittemlitiare analyzed to provide
an indication of the expected performance of the circuit

e Timing Simulation — the fitted circuit is tested to verify both its functionakm@xtness and timing

e Programming and Configuration — the designed circuit is implemented in a physical FPGA tlyijpro-
gramming the configuration switches that configure the LEsemtablish the required wiring connections

This tutorial introduces the basic features of the Quartseftware. It shows how the software can be used to
design and implement a circuit specified by using the Vetilagdware description language. It makes use of the
graphical user interface to invoke the Quartus Il commaBdsng this tutorial, the reader will learn about:

e Creating a project

Design entry using Verilog code

Synthesizing a circuit specified in Verilog code

Fitting a synthesized circuit into an Altera FPGA

Assigning the circuit inputs and outputs to specific pinstenEPGA

Simulating the designed circuit

e Programming and configuring the FPGA chip on Altera’s DE2rbHoa

1 Getting Started

Each logic circuit, or subcircuit, being designed with Quarl software is called pgroject The software works
on one project at a time and keeps all information for thajgmtan a single directory (folder) in the file system.
To begin a new logic circuit design, the first step is to creatirectory to hold its files. To hold the design files
for this tutorial, we will use a directorintrotutorial. The running example for this tutorial is a simple circuit fo
two-way light control.

Start the Quartus Il software. You should see a display ambd the one in Figure 2. This display consists
of several windows that provide access to all the featuréduzrtus Il software, which the user selects with the
computer mouse. Most of the commands provided by Quartudtivare can be accessed by using a set of menus
that are located below the title bar. For example, in Figuolicking the left mouse button on the menu named
File opens the menu shown in Figure 3. Clicking the left mouseobutin the entryExit exits from Quartus Il
software. In general, whenever the mouse is used to seledthing, thdeft button is used. Hence we will not
normally specify which button to press. In the few cases whismecessary to use thmigght mouse button, it will
be specified explicitly.



File Edit Wiew Project Assignments Processing Tools Window Help

“D@ggL $BRER|o o s ee s |T(r oD |k |0|® | W
Project Navig: ax

Entity |

& Compilation Hie'an:hy]

~ idyHierarchy | B Files | & Design Units |

QUARTUS II

Task
LG Version 9.0

® View New Quartus Il
Information

| ® Documentation

x| Tvpe | |

é System /P ing , Extialnfo i Info }, Warming J, Critical Waming J, Enror J, Suppressed } Flag /
glMessage: ﬁ] il ch-cahon _v] Lo

Ready [ [Eonsw | Idie N TV Y |

< I

Figure 2. The main Quartus Il display.
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For some commands it is hecessary to access two or more nreseglence. We use the conventidenul
> Menu2 > Item to indicate that to select the desired command the user dliost click the left mouse button
on Menul, then within this menu click oMenu2, and then withirMenu2 click on Iltem. For exampleFile >
Exit uses the mouse to exit from the system. Many commands candieeih by clicking on an icon displayed in
one of the toolbars. To see the command associated with anposition the mouse over the icon and a tooltip
will appear that displays the command name.

1.1 Quartus Il Online Help

Quartus |l software provides comprehensive online docuatiam that answers many of the questions that may
arise when using the software. The documentation is acddss® theHelp menu. To get some idea of the
extent of documentation provided, it is worthwhile for tieader to browse through tlelp menu. For instance,
selectingHelp > How to Use Help gives an indication of what type of help is provided.

The user can quickly search through the Help topics by setgktelp > Search, which opens a dialog box
into which keywords can be entered. Another method, corstersitive help, is provided for quickly finding
documentation for specific topics. While using most appiices, pressing th&1 function key on the keyboard
opens a Help display that shows the commands availabledaghlication.

2 Starting a New Project

To start working on a new design we first have to define a design project Quartus Il software makes the
designer’s task easy by providing support in the form wfizard Create a new project as follows:

1. SelecFile > New Project Wizard to reach the window in Figure 4, which asks for the name arettiry
of the project.

New Project Wizard: Directory, Name, Top-Level Entity [page 1 of 5]

‘what iz the working directory for this project?

|D:.-"intr0tut0rial
‘what iz the name of this project?
[ight

‘what iz the name of the top-level design entity for this project? Thiz name iz caze sensitive and must
exactly match the entity name in the design file.

light [

Usze Existing Project Settings ...

| Mest > | Finizh | Cancel

Figure 4. Creation of a new project.



2. Set the working directory to biatrotutorial; of course, you can use some other directory name of your
choice if you prefer. The project must have a name, whichusilisthe same as the top-level design entity
that will be included in the project. Chookght as the name for both the project and the top-level entity, as
shown in Figure 4. Presdext. Since we have not yet created the directiotyotutorial, Quartus Il software
displays the pop-up box in Figure 5 asking if it should crehtedesired directory. Clickes, which leads
to the window in Figure 6.

1 E Directory "Dt fintrotutorial” does not exist, Do you wank to create it?
L

es Mo |

Figure 5. Quartus Il software can create a new directorytferroject.
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Figure 6. The wizard can include user-specified design files.

3. The wizard makes it easy to specify which existing fileali§) should be included in the project. Assuming
that we do not have any existing files, clidlext, which leads to the window in Figure 7.
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Figure 7. Choose the device family and a specific device.

4. We have to specify the type of device in which the desigiredi¢ will be implemented. Choose Cycloh¥
Il as the target device family. We can let Quartus Il softweetect a specific device in the family, or we can
choose the device explicitly. We will take the latter apmtmaFrom the list of available devices, choose the
device called EP2C35F672C6 which is the FPGA used on A&¥&?2 board. Preddext, which opens the
window in Figure 8.
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Figure 8. Other EDA tools can be specified.



5. The user can specify any third-party tools that shoulddmeiu A commonly used term for CAD software
for electronic circuits i€£DA tools where the acronym stands for Electronic Design Automafids term
is used in Quartus Il messages that refer to third-partystaghich are the tools developed and marketed
by companies other than Altera. Since we will rely solely ara€us Il tools, we will not choose any other
tools. Presdext.

6. A summary of the chosen settings appears in the screemshdwigure 9. PresBinish, which returns to
the main Quartus Il window, but witlight specified as the new project, in the display title bar, aeted
in Figure 10.

New Project Wizard: Summary [page 5 of 5] @

‘When you click Finish, the project will be created with the following settings:

Project directory:
D:/introtutorial/

Project hame: light
Top-level design entity: light
Number of files added: 0

Number of user libraries added: 0
Device assignments:

Family name: Cyclone Il

Device: EP2C35F672C6
EDA tools:

Design entry/synthesis: <None>

Simulation: <None>

Timing analysis: <None>

Operating conditions:
Core voltage: 1.2¢
Junction temperature range:  0-85 °C

< Back Finish Cancel
| I | |

Figure 9. Summary of the project settings.
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Figure 10. The Quartus Il display for the created project.

3 Design Entry Using Verilog Code

As a design example, we will use the two-way light controtliecuit shown in Figure 11. The circuit can be used
to control a single light from either of the two switcheg,andz2, where a closed switch corresponds to the logic
value 1. The truth table for the circuit is also given in theufigg Note that this is just the Exclusive-OR function

of the inputsz; andx,, but we will specify it using the gates shown.
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Figure 11. The light controller circuit.

The required circuit is described by the Verilog code in Feggi2. Note that the Verilog module is called
light to match the name given in Figure 4, which was specified wherptbject was created. This code can be
typed into a file by using any text editor that stores ASCIIisfiler by using the Quartus Il text editing facilities.
While the file can be given any name, it is a common designeggtipe to use the same name as the name of the
top-level Verilog module. The file name must include the egtenv, which indicates a Verilog file. So, we will
use the naméght.v.



module light (x1, x2, f);

input x1, x2;

output f;

assign f = (x1 & ~x2) | (~x1 & x2);
endmodule

Figure 12. Verilog code for the circuit in Figure 11.

3.1 Using the Quartus Il Text Editor

This section shows how to use the Quartus Il Text Editor. Yanuskip this section if you prefer to use some other
text editor to create the Verilog source code file, which wik mémelight.v.

SelectFile > New to get the window in Figure 13, choo%erilog HDL File, and clickOK. This opens the
Text Editor window. The first step is to specify a name for theetfiat will be created. SeleEile > Save As to
open the pop-up box depicted in Figure 14. In the box lab8kaek as type chooseVerilog HDL File. In the
box labeledFile name typelight. Put a checkmark in the bokdd file to current project. Click Save, which
puts the file into the directorintrotutorial and leads to the Text Editor window shown in Figure 15. Maxani
the Text Editor window and enter the Verilog code in Figuréritd it. Save the file by typingile > Save, or by
typing the shortcuCtrl-s.

Most of the commands available in the Text Editor are setfi@xatory. Text is entered at tivesertion point
which is indicated by a thin vertical line. The insertion potan be moved either by using the keyboard arrow
keys or by using the mouse. Two features of the Text Editoreapecially convenient for typing Verilog code.
First, the editor can display different types of Verilogtstaents in different colors, which is the default choice.
Second, the editor can automatically indent the text on alimevgo that it matches the previous line. Such options
can be controlled by the settingsTools > Options > Text Editor.
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Memory Initislization File
=I- Yerification/Debugging Files
In-System Sources and Probes File
Logic Analyzer Interface File
SignalT ap | Logic Analyzer File
Wector Waveform File
—|- Other Files
AHDL Include File
Block Symbal File
Chain Description File
Synopsys Design Constraints File
Text File

v

Cancel

Figure 13. Choose to prepare a Verilog file.
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Figure 15. Text Editor window.

3.1.1 Using Verilog Templates

The syntax of Verilog code is sometimes difficult for a desigto remember. To help with this issue, the Text
Editor provides a collection oferilog templates The templates provide examples of various types of Verilog
statements, such asr@dule declaration, amlwaysblock, and assignment statements. It is worthwhile to beows
through the templates by selectiidit > Insert Template > Verilog HDL to become familiar with this resource.

3.2 Adding Design Files to a Project

As we indicated when discussing Figure 6, you can tell Quditsoftware which design files it should use as part
of the current project. To see the list of files already ineldith thelight project, selecfssignments > Settings,
which leads to the window in Figure 16. As indicated on thé dafe of the figure, click on the itefiiles. An
alternative way of making this selection is to cho®&seject > Add/Remove Files in Project.

If you used the Quartus Il Text Editor to create the file ancc&bd the box labeleddd file to current project,
as described in Section 3.1, then thght.v file is already a part of the project and will be listed in thexghdw in
Figure 16. Otherwise, the file must be added to the projectif $ou did not use the Quartus Il Text Editor, then
place a copy of the filiéght.v, which you created using some other text editor, into theadaryintrotutorial. To
add this file to the project, click on th&le name: ... button in Figure 16 to get the pop-up window in Figure 17.
Select thdight.v file and clickOpen. The selected file is now indicated in the Files window of Fgli6. Click
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OK to include thdight.v file in the project. We should mention that in many cases thar@s Il software is able
to automatically find the right files to use for each entityerehced in Verilog code, even if the file has not been
explicitly added to the project. However, for complex prtgethat involve many files it is a good design practice
to specifically add the needed files to the project, as dest@above.
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Libraries Select the design files you want to include in the project. Click &dd &l to add all design files in the:
Dievice project directary to the project.
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i Temperature
S+ EaiplationFisCess Settings File name: | Tupe | Library | Desianentiy/s... | HDL version  Add Al
i Earlt Timing E stimate light.+ Verilog HOL... <Nans>

- Incremental Compilation
- ED& Tool Settings

- Dresign Entry/Synthesis

- Simulation

- Timing Analyzis
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= Analyzis & Synthesis Seftings
- WHDL Input
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- Default Parameters
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o Physzical Synthesis O ptimization
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Figure 16. Settings window.
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Figure 17. Select the file.
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4 Compiling the Designed Circuit

The Verilog code in the fildight.v is processed by several Quartus Il tools that analyze the, @yathesize the
circuit, and generate an implementation of it for the taj@p. These tools are controlled by the application
program called th€ompiler.

Run the Compiler by selectingrocessing > Start Compilation, or by clicking on the toolbar ico ® that
looks like a purple triangle. As the compilation moves tlglwarious stages, its progress is reported in a window
on the left side of the Quartus Il display. Successful (orugnessful) compilation is indicated in a pop-up box.
Acknowledge it by clickingOK, which leads to the Quartus Il display in Figure 18. In the sage window, at the
bottom of the figure, various messages are displayed. Inafaseors, there will be appropriate messages given.
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Figure 18. Display after a successful compilation.

When the compilation is finished, a compilation report is pict. A window showing this report is opened
automatically, as seen in Figure 18. The window can be résip@ximized, or closed in the normal way, and it

can be opened at any time either by selecBngcessing > Compilation Report or by clicking on the icor .

The report includes a number of sections listed on the Id# sff its window. Figure 18 displays the Compiler
Flow Summary section, which indicates that only one logarent and three pins are needed to implement this
tiny circuit on the selected FPGA chip.

4.1 Errors

Quartus Il software displays messages produced duringitatiop in the Messages window. If the Verilog design
file is correct, one of the messages will state that the catipil was successful and that there are no errors.

If the Compiler does not report zero errors, then there isadtlone mistake in the Verilog code. In this case
a message corresponding to each error found will be displaythe Messages window. Double-clicking on an
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error message will highlight the offending statement in\thélog code in the Text Editor window. Similarly, the
Compiler may display some warning messages. Their detaildoe explored in the same way as in the case of
error messages. The user can obtain more information alspédific error or warning message by selecting the
message and pressing thg function key.

To see the effect of an error, open the fiht.v. Remove the semicolon in tlessignstatement, illustrating a
typographical error that is easily made. Compile the emosalesign file by clicking on th® icon. A pop-up
box will ask if the changes made to thght.v file should be saved; clickes. After trying to compile the circuit,
Quartus Il software will display a pop-up box indicatingtttiee compilation was not successful. Acknowledge it
by clicking OK. The compilation report summary, given in Figure 19, nowfirors the failed result. Expand the
Analysis & Synthesis part of the report and then selddessages to have the messages displayed as shown in
Figure 20. Double-click on the first error message. Quailtgsftware responds by opening thght.v file and
highlighting the statement which is affected by the errerslaown in Figure 21. Correct the error and recompile
the design.

> Compilation Report - Flow Summary

Compilation Report Flow Summary
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Total pins N/A until Partition Merge
Total virtual pins N/A until Partition Merge
Total memory bits N/A until Partition Merge
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< > v

Figure 19. Compilation report for the failed design.
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Figure 20. Error messages.
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£@s light.v

1 BEmodule light(xl,x2,£):
2 input x1,x&;
3 output £
4 assign £ = (®X1&~x2)| (~x1l&x2)
5

Figure 21. Identifying the location of the error.

5 Pin Assignment

During the compilation above, the Quartus Il Compiler waefto choose any pins on the selected FPGA to serve
as inputs and outputs. However, the DE2 board has hardwinelections between the FPGA pins and the other
components on the board. We will use two toggle switchegl¢aks 1V, and ST, to provide the external inputs,

x1 andzs, to our example circuit. These switches are connected tBRI@A pins N25 and N26, respectively. We
will connect the outpuy to the green light-emitting diode labeléd” DGy, which is hardwired to the FPGA pin
AE22.

€ Quartus Il - D:/introtutorial/light - light - [Assignment Editor]
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1 <<new>> [ |
3
ff
1z
Einl
2
ke 4
i g
¢ | 4
«» < >
Ready NUM

Figure 22. The Assignment Editor window.

Pin assignments are made by using the Assignment EditoectS&dsignments > Assignment Editor to
reach the window in Figure 22. Und@ategory selectPin. Double-click on the entry<<new>> which is
highlighted in blue in the column labeled To. The drop-dowenmin Figure 23 will appear. Click anl as the
first pin to be assigned,; this will ented in the displayed table. Follow this by double-clicking oe thox to the
right of this newx1 entry, in the column labeled Location. Now, the drop-dowmmin Figure 24 appears. Scroll
down and seled?IN_N25. Instead of scrolling down the menu to find the desired pim, gan just type the name
of the pin (N25) in the Location box. Use the same procedugessign input:2 to pin N26 and outpuf to pin
AE22, which results in the image in Figure 25. To save thegassents made, choosdée > Save. You can also
simply close the Assignment Editor window, in which case p-pp box will ask if you want to save the changes
to assignments; clickes. Recompile the circuit, so that it will be compiled with thergect pin assignments.

To
\ -
o f

il
2

Figure 23. The drop-down menu displays the input and outpotas.
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Location | 1f0 Bank If0 standard General Function Special Fur

| PIn_hizs] -5 33N LYTTL Dedicated Clock Lk, LWDE
PIN_MzZ IJOBank5  Row IO LvDS1Z2p ~
PIN_M23 IO Bank 5 Row IjO LVDS122n

PIN_Mz24 IjOBank5  Row IO L¥DS1250

PIN_M25 IO Bank 5 Row IjO LVDS125n

PIN_M1 Ij0 Bank 2 Dedicated Clock CLE1, LVDSCLKOR, Input

PIN_MZ Ij0 Bank 2 Dedicated Clock CLED, LVDSCLKOp, Input

PIN_NS IjOBank?  Row IO L¥DS31p

PIN_N1E IjOBank5  Row IO L¥DS110p

PIN_NZ0 IjOBank5  Row IO L¥DS124p

PIN_NZS IjOBank5  Row IO L¥DS126p, DPCLKFDOSOR/CGIR

Ij0 Bank 5

L O Bank 5 Dec ik &L fnout

PIN_NZ26 Ij0 Bank 5 Dedicated Clock CLKS, LYDSCLKZn, Input

PIN_P1 I} Bank 1 Dedicated Clock CLES, LYDSCLK 1R, Input

PIN_PZ2 Ij0 Bank 1 Dedicated Clock CLKZ, LVDSCLK 1p, Input

PIN_P3 LOBank1  Row Lo L¥D526p, DPCLKL/DQS1LCQILE

PIN_P4 LOBank1  Row O LVD526n

PIN_P& LOBank1  Row O LVDS22n

PIN_P7 LOBank1  Row O LVDS22p

PIN_PD LOBankz  Row O LVDS31n v

Figure 24. The available pins.

€ Quartus Il - D:/introtutorial/light - light - [Assignment Editor]

File Edit Yiew Tools Window

[@ i +  Category: | Pin LI @ all @ Timing | # Logic Options
& o Edit: X | [<znew>> ]

To Location IfO Bank /O Standard General Function Special Function |Reserved

1 B> x1 PIN_N2S S 3,3-V LYTTL di Cl CLK4, LYDSCLK2p, In

= 2 B x2 PIN_N26 5 3.3-VLYTTL Cl K2n, In...

il 3 o f PIN_AE22 7 3.3 LYTTL [

4 <<news >

12

& &

> 2

b 4

i Z

< | 4

«» < 5>
Ready UM

Figure 25. The complete assignment.

The DE2 board has fixed pin assignments. Having finished osigmethe user will want to use the same
pin assignment for subsequent designs. Going through theedure described above becomes tedious if there
are many pins used in the design. A useful Quartus Il featilwe/sithe user to both export and import the pin
assignments from a special file format, rather than crediegn manually using the Assignment Editor. A simple
file format that can be used for this purpose isetbenma separated value (CSi@ymat, which is a common text
file format that contains comma-delimited values. This filefat is often used in conjunction with the Microsoft
Excel spreadsheet program, but the file can also be createaruyusing any plain ASCII text editor. The format
for the file for our simple project is

To, Location
x1, PIN_N25
x2, PIN_N26
f, PIN_AE22

By adding lines to the file, any number of pin assignments eacrbated. Sucbsvfiles can be imported into any
design project.

If you created a pin assignment for a particular project, ga export it for use in a different project. To see
how this is done, open again the Assignment Editor to reaelwthdow in Figure 25. Now, sele€ile > Export
which leads to the window in Figure 26. Here, the fight.csvis available for export. Click ofExport. If you
now look in the directoryntrotutorial, you will see that the filéight.csvhas been created.
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Save in: | 1233 intratutarial LJ g =k EB-
.| Db
»
My Recent
Documents
o
[esklop
My Documents
|
%9
My Computer
3
My Metwork, File name: Iiu:]h LJ E=port |
Flaces
Save as type: |C0mma Separated Value File [*.cav) ﬂ Cancel

Figure 26. Exporting the pin assignment.

You can import a pin assignment by choosigsignments > Import Assignments. This opens the dia-
logue in Figure 27 to select the file to import. Type the namtheffile, including thecsvextension and the full
path to the directory that holds the file, in the File Name bad pressOK. Of course, you can also browse to find
the desired file.

Import Assignments @

Specify the source and categories of assignments ta import.

FEile name: I _J
[t

v Copy existing assignments into light.gsf.bak before importing

| Cancel |

Figure 27. Importing the pin assignment.

For convenience when using large designs, all relevantgsigaments for the DE2 board are given in the file
calledDE2_pin_assignments.c8vthe directoryDE2_tutorials design_fileswhich is included on the CD-ROM
that accompanies the DE2 board and can also be found on AlBE2 web pages. This file uses the names found
in the DE2 User Manual If we wanted to make the pin assignments for our exampleauitiby importing this
file, then we would have to use the same names in our Verilogmuiéite; namely,SW[0], SW[1] andLEDG|0]
for x1, x2 andf, respectively. Since these signals are specified irDfe2 pin_assignments.cfile as elements
of vectorsSWandLEDG, we must refer to them in the same way in the Verilog design Rler example, in the
DE2_pin_assignments.cfile the 18 toggle switches are call&¥V[17]to SW[0]. In Verilog code, they can also
be referred to as a vect&W[17:0}

6 Simulating the Designed Circuit

Before implementing the designed circuit in the FPGA chiptlom DE2 board, it is prudent to simulate it to
ascertain its correctness. Quartus Il software includésalation tool that can be used to simulate the behavior
of a designed circuit. Before the circuit can be simulatets necessary to create the desired waveforms, called
test vectorsto represent the input signals. Itis also necessary tafgpelaich outputs, as well as possible internal
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points in the circuit, the designer wishes to observe. Theukitor applies the test vectors to a model of the
implemented circuit and determines the expected respalsawill use the Quartus Il Waveform Editor to draw
the test vectors, as follows:

1. Open the Waveform Editor window by selectifide > New, which gives the window shown in Figure 28.
Choosevector Waveform File and clickOK.

2. The Waveform Editor window is depicted in Figure 29. Sdeeftle under the nameght.vwf, note that this
changes the name in the displayed window. Set the desiradation to run from 0 to 200 ns by selecting
Edit > End Time and entering 200 ns in the dialog box that pops up. Sele&fiagy > Fit in Window
displays the entire simulation range of 0 to 200 ns in the aincs shown in Figure 30. You may wish to
resize the window to its maximum size.

SOPC Builder System A
=1 Design Files
AHDL File
Block Diagiam?S chematic File
EDIF File
State Maching File
Sestemerilag HOL File
Tel Script File
“erilog HOL File
HOL File
=1 Memoary Files
Hexadecimal (Intel-Farmat] File
Memary Initialization File
=1 Verification/Debugging Files
In-System Sources and Probes File
Lagic Analyzer Interface File
SignalT ap Il Logic Analyzer File
farm File:

=I- Other Files
AHDL Include File
Block Symbal File
Chain Description File
Synopsys Design Constraints File
Test File 2

Cancel

Figure 28. Need to prepare a new file.

B light. vwf
Master Time Bar: 15.95 nz 4| +| Painter: 4.7 nz Interval: 11.25 ns Start: End:
) vaa | PP 100 ns 200 ns |
I 15.95 nz 15.95 ne
< ¥

Figure 29. The Waveform Editor window.
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B light.vwi* 9((=E3

Master Time Bar: 15.95 nz 1| ¥| Painter: 968 nz Interval: £.27 nz Start: 0ps End: 200.0 nz
0 pz 400 nz 80.0 nz 120.0 ns 160.0 nz 200.0 n4
Walue at i i i i
Name 15.95 nz 15.95 ne
|

Figure 30. The augmented Waveform Editor window.

3. Next, we want to include the input and output nodes of theuitito be simulated. ClickEdit > Insert >
Insert Node or Bus to open the window in Figure 31. It is possible to type the nafre signal (pin) into
the Name box, but it is easier to click on the button labéliedie Finder to open the window in Figure
32. The Node Finder utility has a filter used to indicate wigpetof nodes are to be found. Since we are
interested in input and output pins, set the filtePios: all. Click the List button to find the input and
output nodes as indicated on the left side of the figure.

Insert Node or Bus rz|
Mame: | (] 8 |
Type: |INF'UT j Cancel
Value type: |9-LEVE| j Mode Finder...
Fiadix s -]

Bus width: |'I
Start index: |D
[ Display gray code count as binary count

Figure 31. The Insert Node or Bus dialogue.

Mamed: |i j Filter: |Pins: all j Custamize... | List | Q QK |
Lock in: jJ V' Include subentities | Cancel |
Modes Found: Selected Nodes:
Mame Aszzignments | Tupe | Mame Aszsighments | Type
I f PIN_&E22 Output 9 [lightl1 PIN_N25 Input
| PIN_NZ5 Input [ B lightlx2 PIN_MZ2E Input
2 PIN_N26 Input L lightlf PIN_&E22 Output
<
<<
< > J < >

Figure 32. Selecting nodes to insert into the Waveform Edito
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Click on thex1 signal in the Nodes Found box in Figure 32, and then clicktfsign to add it to the Selected
Nodes box on the right side of the figure. Do the samexfandf. Click OK to close the Node Finder
window, and then clickOK in the window of Figure 31. This leaves a fully displayed Wave Editor
window, as shown in Figure 33. If you did not select the noddbé same order as displayed in Figure 33,
it is possible to rearrange them. To move a waveform up or dawime Waveform Editor window, click on
the node name (in the Name column) and release the mousa& biitte waveform is now highlighted to
show the selection. Click again on the waveform and drag dngiown in the Waveform Editor.

B light.vwf =3
Master Time Bar: 15.95 nz 1| ¥| Painter: 10,08 nz Interval: 5.89ns Start: 0ps End: 200.0 nz
0 pz 400 nz 80.0 nz 120.0 ns 160.0 nz 200.0 n4
N Walue at i i i i
aME | 15,95 ns 15-933 ns
w0 «1 A0
1 %2 A0
£ 2 f A

Figure 33. The nodes needed for simulation.

4. We will now specify the logic values to be used for the infighalsx1 andx2 during simulation. The logic
values at the outpudtwill be generated automatically by the simulator. To maleasy to draw the desired
waveforms, the Waveform Editor displays (by default) \eatiguidelines and provides a drawing feature
that snaps on these lines (which can otherwise be invoketdxysingView > Snap to Grid). Observe also
a solid vertical line, which can be moved by pointing to itg tond dragging it horizontally. This reference
line is used in analyzing the timing of a circuit; move it teettime = 0 position. The waveforms can be

drawn using the Selection Tool, which is activated by setgdhe iconk in the toolbar, or the Waveform
Editing Tool, which is activated by the icCH .

To simulate the behavior of a large circuit, it is necessagpply a sufficient number of input valuations and
observe the expected values of the outputs. In a large titeinumber of possible input valuations may
be huge, so in practice we choose a relatively small (buesgmtative) sample of these input valuations.
However, for our tiny circuit we can simulate all four inpwluations given in Figure 11. We will use four
50-ns time intervals to apply the four test vectors.

We can generate the desired input waveforms as follows.k @iicthe waveform name for thel node.
Once a waveform is selected, the editing commands in the Mfawd=ditor can be used to draw the desired
waveforms. Commands are available for setting a seleagea@lsio 0, 1, unknown (X), high impedance (2),
don't care (DC), inverting its existing value (INV), or deifig a clock waveform. Each command can be
activated by using thEdit > Value command, or via the toolbar for the Waveform Editor. The Bu#nu
can also be opened by right-clicking on a waveform name.

Setx1to 0 in the time interval O to 100 ns, which is probably alreadyby default. Next, setl to 1 in the
time interval 100 to 200 ns. Do this by pressing the mouseeastart of the interval and dragging it to its
end, which highlights the selected interval, and choodiegdagic value 1 in the toolbar. Make = 1 from
50 to 100 ns and also from 150 to 200 ns, which correspond<sttriith table in Figure 11. This should
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produce the image in Figure 34. Observe that the oufpsitdisplayed as having an unknown value at this
time, which is indicated by a hashed pattern; its value vélbletermined during simulation. Save the file.

Master Time Bar: 0ps 1| ¥| Painter: 166.25 ng Interval: 166.25 ng Start: End:

0 pz 200 nz 400 nz B0.0 nz 80.0 nz 100.0 ns 120.0 ns 140.0 nz 160.0 nz 180.0 nz |

. Value at i i i i i i i i i
0ps ? pz

w0 «1 A0 |
1 %2 A0 |
£ 2 f A

< ¥

Figure 34. Setting of test values.

6.1 Performing the Simulation

A designed circuit can be simulated in two ways. The simplest is to assume that logic elements and intercon-
nection wires in the FPGA are perfect, thus causing no delgyapagation of signals through the circuit. This
is calledfunctional simulation A more complex alternative is to take all propagation deliayo account, which
leads tatiming simulation Typically, functional simulation is used to verify the fttional correctness of a circuit
as it is being designed. This takes much less time, becaasgrttulation can be performed simply by using the
logic expressions that define the circuit.

6.1.1 Functional Simulation

To perform the functional simulation, sele&ssignments > Settings to open the Settings window. On the left
side of this window click orSimulator Settings to display the window in Figure 35, chooBenctional as the
simulation mode, and clic®K. The Quartus Il simulator takes the inputs and generatesutpaits defined in the
light.vwffile. Before running the functional simulation it is neceyda create the required netlist, which is done
by selectingProcessing > Generate Functional Simulation Netlist. A simulation run is started blfrocess-

ing > Start Simulation, or by using the icor®. At the end of the simulation, Quartus Il software indicdtes
successful completion and displays a Simulation Repastithted in Figure 36. If your report window does not
show the entire simulation time range, click on the reportdeiv to select it and chood&ew > Fit in Window.
Observe that the outpiftis as specified in the truth table of Figure 11.
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Settings - light

Category:

- Libraries A
Device I

- Dperating Settings and Conditions Select simulation options.

- Woltage

o Temperature =
- Compilation Process Settings :

- Early Timing E stimate Simulation input: |Iight.vwf _J Add Multiple Files...

s Incremental Compilation
- EDA, Tool Settings — Simulation period

- Design Entry/Synthesis ' Rur simulation untl all vector stimul are used
- Simulation

o Timning Analyziz " End simulation at; i r ]
- Formal Verification

- Physical Synthesis Gliteh filtering options:
; g options: | ALt sl
- Board-Level 1 _J

— Analyzis & Synthesiz Settings More Settings...

- WHDL Input
- Werilog HOL Input
- Default Parameters
o Synthesis Metlist Optimizations
- Fitter Settings
s Phyzical Synthesis O ptimization
- Timing Analyziz Settings
- TimeGuest Timing Analyzer
= Claszic Timing &nalyzer Setting
: " Classic Timing Analyzer Re
- Azzembler Drescriptior:
- Diesign Assistant Specifies the type of simulation to perform for the current Simulation focus.
- SignalTap Il Logic Analyzer
Logic Analyzer Interface
- Simulator Settings
PowerFlay Power Analyzer Setting -

22 | > B ok | Cancel

Simulation mode: |{Z8

i

Figure 35. Specifying the simulation mode.

Simulation Waveforms
Simulation mode: Functional

h Master Time Bar: 0ps 1| ¥| Painter: BE4.33 nz Interval: BE4.33 nz Start: End:
A 0 pz 400 nz 80.0 nz 120.0 ns 160.0 nz 200.0 n4
N Walue at i i i i
o5 ame Ops 0 s
i

@\ w0 «1 A0 |

1 %2 A0 I | J
Iy £ 2 f A0 | |
%,

Figure 36. The result of functional simulation.

6.1.2 Timing Simulation

Having ascertained that the designed circuit is functigradrrect, we should now perform the timing simulation
to see how it will behave when it is actually implemented ia thosen FPGA device. Sele&ssignments >
Settings > Simulator Settings to get to the window in Figure 35, choo$@ning as the simulation mode, and
click OK. Run the simulator, which should produce the waveforms guig 37. Observe that there is a delay of
about 6 ns in producing a change in the sigfidiom the time when the input signals; andx,, change their
values. This delay is due to the propagation delays in thie Elgment and the wires in the FPGA device.
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Simulation Waveforms I
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Figure 37. The result of timing simulation.

7 Programming and Configuring the FPGA Device

The FPGA device must be programmed and configured to impletmedesigned circuit. The required configura-
tion file is generated by the Quartus Il Compiler’'s Assembiedule. Altera’s DE2 board allows the configuration
to be done in two different ways, known as JTAG and AS mode& cidmfiguration data is transferred from the
host computer (which runs the Quartus 1l software) to thedbdy means of a cable that connects a USB port
on the host computer to the leftmost USB connector on thedbdar use this connection, it is necessary to have
the USB-Blaster driver installed. If this driver is not ady installed, consult the tutori@etting Started with
Altera’s DE2 Boardfor information about installing the driver. Before usidggtboard, make sure that the USB
cable is properly connected and turn on the power supplychwin the board.

In the JTAG mode, the configuration data is loaded directly ihe FPGA device. The acronym JTAG stands
for Joint Test Action Group. This group defined a simple waytésting digital circuits and loading data into
them, which became an IEEE standard. If the FPGA is configurdétis manner, it will retain its configuration
as long as the power remains turned on. The configuratiomnaftion is lost when the power is turned off. The
second possibility is to use the Active Serial (AS) mode.his tase, a configuration device that includes some
flash memory is used to store the configuration data. Quartaftivare places the configuration data into the
configuration device on the DE2 board. Then, this data isddéato the FPGA upon power-up or reconfiguration.
Thus, the FPGA need not be configured by the Quartus Il softifaine power is turned off and on. The choice
between the two modes is made by the RUN/PROG switch on thelid&@l. The RUN position selects the JTAG
mode, while the PROG position selects the AS mode.

7.1 JTAG Programming

The programming and configuration task is performed asv@loFlip the RUN/PROG switch into the RUN
position. Selecflools > Programmer to reach the window in Figure 38. Here it is necessary to §pdice
programming hardware and the mode that should be used. Hlresdy chosen by default, select JTAG in the
Mode box. Also, if the USB-Blaster is not chosen by defauless theHardware Setup... button and select the
USB-Blaster in the window that pops up, as shown in Figure 39.

u light.cdf

éa Hardware Setup...| | U5E-Blaster [USE-0]

™ Enable realtime ISP ta allow background prograrring (for MAK || devices)

Mode: [JTAG | Progress: 0%

Blark-
Check

Frogram/
Configure

Wi Start | File

sis |
*E'ﬂ Auto Detect
Xoeke |
(2 4dd File...

IE >

Uszercode Examine

FFFFFFFF

Device
EP2C3I5FET2

Werify

‘ Checksum
O02Fg284

light. zof

Figure 38. The Programmer window.
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Observe that the configuration flight.sofis listed in the window in Figure 38. If the file is not alreadistéd,
then click Add File and select it. This is a binary file produced by the Compil&ssembler module, which
contains the data needed to configure the FPGA device. Tleasrh.sofstands for SRAM Object File. Note
also that the device selected is EP2C35F672, which is theAFRSice used on the DE2 board. Click on the

Program/Configure check box, as shown in Figure 40.

Hardware Setup

Hardware Seftings I.JTAG Sgttings]

X

Select a programming hardware getup to use when programming devices. This programming
hardware zetup applies only ta the current programmer window.
Currently selected hardware: USB-Blaster [USE-0]
Available hardware items:
Hardware Server | Fart | Add Hardware...
USE-Elaster Local Use-0

Figure 39. The Hardware Setup window.

U light.cdf*

éa Hardware Setup...| | U5E-Blaster [USE-0]

™ Enable realtime ISP ta allow background prograrring (for MAK || devices)

Mode: [JTAG | Progress: 0%

Wb Start

*E'ﬂ Auto Detect
¥ Delete

s Add File...

li= Change File... |

Checksum

Uszercode

FFFFFFFF

Figure 40. The updated Programmer window.

Now, pressStart in the window in Figure 40. An LED on the board will light up winéhe configuration data
has been downloaded successfully. If you see an error mgpbytQuartus Il software indicating that programming

failed, then check to ensure that the board is properly pesven.

7.2 Active Serial Mode Programming

In this case, the configuration data has to be loaded into dhégurration device on the DE2 board, which is
identified by the name EPCS16. To specify the required corstgn device selecAssignments > Device,
which leads to the window in Figure 41. Click on tBevice and Pin Options button to reach the window in
Figure 42. Now, click on th€onfiguration tab to obtain the window in Figure 43. In the Configurationidev
box (which may be set to Auto) choose EPCS16 and ¢lisk Upon returning to the window in Figure 41, click
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OK. Recompile the designed circuit.

Settings - light

Category:

- General
Files
Libraries
- Device
+ Operating Settings and Conditions
i+ Compilation Process Settings
EDA, Tool Settings
i+ Analysis & Synthesis Settings
i+ Fitter Settings
i Timing &nalysiz Settings
- Azzembler
- Design Assistant
- SignalTap Il Logic Analyzer
Logic Analyzer Interface
- Simulator Settings
- PowerPlay Power Analyzer Settings

-

X

Select the family and device you want to target for compilation.

~Device family = Show in Available devices' list—
FEamily: ]Eyclone Il l! Package: Ay -
L i m ___! Fin count: Ary -

Spged grade: !Any vi

[~ Show advanced devices
. Auto device selected by the Fitter il

- Target device

* Specific device selected in ‘tuvallable devices' list
=] f

Device and Pin Dptions... J

Ayailable devices:

Mame { Corew.. | LEs i Userlf.. | Memor.. | Embed.. | PLL 4|
EP2C200240C8 1.2 18752 142 ZI9E16 B2 4
EP2C35F484CE 1.2¢ 33218 322 483840 70 4
EP2C35F484C7 1.4 33216 322 483840 70 4
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EP2C35F454/8 1.2 33216 322 483840 70 4

1 4 L, 4

1.2¢ 70 4 |

i~ Migration compatibility ————— -

Migration Devices. ..

0 migration devices selected

Cancel l

Figure 41. The Device Settings window.

Device and Pin Options

Voltage
Capacitive Loading

] Pin Placement I Error Detection CRC l
I Board Trace Model I 170 Timing [

General ] Configuration ] Programming Files I Unused Pins I Dual-Purpose Pins l

Specify general device options. These options are not dependent on the configuration
scheme.

Options:

Auto-restart configuration after error
["|Release clears before tri-states

[]Enable user-supplied start-up clock [CLKUSR)
["]Enable device-wide reset ([DEV_CLRn)
["]Enable device-wide output enable (DEY_0E)
[]Enable INIT_DONE output

[~ Auto usercode

JTAG user code (32-bit hexadecimal:  |FFFFFFFF
Description:

Directs the device to restart the configuration process automatically if a data error is
encountered. If this option is turned off, you must extemally direct the device to

restart the configuration process if an error occurs.
Reset
0K I

In-system programming

3y entry to L

Cancel |

Figure 42. The Options window.
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Device and Pin Options @

Voltage ] Pin Placement ] Error Detection CRC ]
Capacitive Loading I Board Trace Model I 170 Timing I
General  Configuration I Programming Files ] Unused Pins l Dual-Purpose Pins ]

Specify the device configuration scheme and the configuration device. Note: For
HardCopy designs, these settings apply to the FPGA prototype device.

Configuration scheme: IActive Serial [can use Configuration Device) L]
Configuration mode: | _]

Configuration device
v Use configuration device: Auto L]

-

|v Generate compressed bitstreams

Description:

Specifies the configuration device that you want to use as the means of configuring
the target device.

Reset
oK I Cancel |

Figure 43. Specifying the configuration device.

The rest of the procedure is similar to the one describedexfimthe JTAG mode. Sele®bols > Program-
mer to reach the window in Figure 38. In the Mode box selsctive Serial Programming. If you are changing
the mode from the previously used JTAG mode, the pop-up bd&igare 44 will appear, asking if you want to
clear all devices. Clickes. Now, the Programmer window shown in Figure 45 will appeaak®lsure that the
Hardware Setup indicates the USB-Blaster. If the configomdtle is not already listed in the window, preadd
File. The pop-up box in Figure 46 will appear. Select the liggat.pof in the directoryintrotutorial and click
Open. As a result, the configuration filgght.pofwill be listed in the window. This is a binary file produced by
the Compiler's Assembler module, which contains the dataetéoaded into the EPCS16 configuration device.
The extensionpof stands for Programmer Object File. Upon returning to theggRnmmer window, click on the
Program/Configure check box, as shown in Figure 47.

'E Some devices in current device list cannot be added to selected programming mode Active Serial Programming. Do you want ko clear all devices in
L

current device list and switch to selected mode?

Figure 44. Clear the previously selected devices.
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éa Hardware Setup...| | U5B-Blaster [USE-0]

Mode: | Active Serial Programming + | Progress:

™ Enable realtime ISP ta allow background prograrring (for MAK || devices)

Frogram/
Configure
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Figure 45. The Programmer window with Active Serial Progminyg selected.
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Look in: It'_:) introtutarial L‘ - ﬁ( Ea-

Db
|Cincremental_db

My Recent light.pof
Documents |
Desktop

My Documents
My Computer

Mypblletwork File name: [light pot ~| Open
laces
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Figure 46. Choose the configuration file.
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Figure 47. The updated Programmer window.
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Flip the RUN/PROG switch on the DE2 board to the PROG positiBressStart in the window in Figure
47. An LED on the board will light up when the configurationalats been downloaded successfully. Also, the
Progress box in Figure 47 will indicate when the configuraiod programming process is completed, as shown
in Figure 48.
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Figure 48. The Programmer window upon completion of prognémg.

8 Testing the Designed Circuit

Having downloaded the configuration data into the FPGA dgwou can now test the implemented circuit. Flip
the RUN/PROG switch to RUN position. Try all four valuatioosthe input variables:; andz,, by setting the
corresponding states of the switchgB’; and. SW,. Verify that the circuit implements the truth table in Figur
11.

If you want to make changes in the designed circuit, firsteltee Programmer window. Then make the
desired changes in the Verilog design file, compile the dirand program the board as explained above.
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